# Graphics Options

Revised: 10/10/2017

Summary

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphics Options</td>
<td>3</td>
</tr>
<tr>
<td>Graphics Panes</td>
<td>4</td>
</tr>
<tr>
<td>Resizing a Graph</td>
<td>5</td>
</tr>
<tr>
<td>Identifying Points</td>
<td>6</td>
</tr>
<tr>
<td>Locating a Position on a Graph</td>
<td>7</td>
</tr>
<tr>
<td>Enlarging a Portion of the Graph</td>
<td>8</td>
</tr>
<tr>
<td>Moving or Deleting Text</td>
<td>9</td>
</tr>
<tr>
<td>Analysis Toolbar</td>
<td>10</td>
</tr>
<tr>
<td>Graphics Options</td>
<td>10</td>
</tr>
<tr>
<td>Adding Text</td>
<td>11</td>
</tr>
<tr>
<td>Jittering Points</td>
<td>12</td>
</tr>
<tr>
<td>Brushing Scatterplots</td>
<td>13</td>
</tr>
<tr>
<td>Smoothing a 2D Scatterplot</td>
<td>16</td>
</tr>
<tr>
<td>Rotating a 3D Plot</td>
<td>18</td>
</tr>
<tr>
<td>Panning and Zooming</td>
<td>20</td>
</tr>
<tr>
<td>Creating Videos</td>
<td>21</td>
</tr>
<tr>
<td>Exploring Response Surfaces</td>
<td>21</td>
</tr>
<tr>
<td>Identifying Points</td>
<td>23</td>
</tr>
<tr>
<td>Excluding Points</td>
<td>24</td>
</tr>
<tr>
<td>Adding New Objects</td>
<td>25</td>
</tr>
<tr>
<td>Overiding Attributes</td>
<td>28</td>
</tr>
<tr>
<td>Highlighting Points</td>
<td>30</td>
</tr>
<tr>
<td>Locating Points by Name</td>
<td>32</td>
</tr>
<tr>
<td>Locating Points by Row Number</td>
<td>32</td>
</tr>
<tr>
<td>Graphics Options</td>
<td>34</td>
</tr>
<tr>
<td>Layout</td>
<td>34</td>
</tr>
<tr>
<td>Grid</td>
<td>36</td>
</tr>
<tr>
<td>Points</td>
<td>38</td>
</tr>
<tr>
<td>Lines</td>
<td>39</td>
</tr>
</tbody>
</table>

© 2017 by Statgraphics Technologies, Inc.
<table>
<thead>
<tr>
<th>Graphics Options</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Title</td>
<td>40</td>
</tr>
<tr>
<td>X-Axis, Y-Axis, Z-Axis or Right-Axis</td>
<td>41</td>
</tr>
<tr>
<td>Legend</td>
<td>43</td>
</tr>
<tr>
<td>Labels</td>
<td>44</td>
</tr>
<tr>
<td>Text</td>
<td>45</td>
</tr>
<tr>
<td>Fills</td>
<td>46</td>
</tr>
<tr>
<td>Palette</td>
<td>48</td>
</tr>
<tr>
<td>Profile</td>
<td>51</td>
</tr>
<tr>
<td>Printing Graphs</td>
<td>53</td>
</tr>
<tr>
<td>Copying Graphs to Other Applications</td>
<td>53</td>
</tr>
<tr>
<td>Saving Graphs</td>
<td>54</td>
</tr>
<tr>
<td>Creating a Video</td>
<td>55</td>
</tr>
</tbody>
</table>
Summary

One of the guiding design principles behind STATGRAPHICS is that graphical output should be as readily available as tabular output within each of the statistical analyses. Consequently, each procedure contains one or more pre-defined graphs that may be selected from the Graphs dialog box. When graphs are initially displayed, default values are selected for titles, scaling, point symbols, etc. For analytical purposes, the defaults often suffice. However, when it is time to prepare a graph for presentation, those defaults can be easily overridden by double-clicking on any graph and selecting Graphics Options from the analysis toolbar or by clicking the alternate mouse.

Another guiding principle is that graphs should do more than present static output. Users should be able to query graphs and inquire about interesting data values, zoom in on selected areas, remove suspected outliers, and otherwise interact with the output. The analysis toolbar and alternate mouse button popup menu contain a collection of buttons and input fields that facilitate this interaction. This document describes each of the available means for interacting with a graph.
Graphics Panes

When graphs are created, they are placed in panes along the righthand side of the analysis window. Double-clicking on a graph enlarges it so that it fills the entire window, as shown below:
Resizing a Graph

By default, graphs are sized so that sufficient room is left around all four edges for titles and legends. Graphs may be resized or moved around the screen in the following manner:

1. To move a graph within the window, hold the left button down on any unused location within the axes and drag it to the desired position.

2. To change the size of the graph, click at any unused location within the graph and release the mouse button. This places four small marks on each corner of the graph.

Then hold the mouse down on any of the four marks and drag a corner. The graph will be resized as the corner is dragged.
Identifying Points

The coordinates of interesting points within a graph may be displayed by clicking on any point and holding the left mouse button down:

The row number of the point in the datasheet will be displayed, together with its coordinates.
Locating a Position on a Graph

To locate a position on a graph, not corresponding to a plotted point, press the alternate mouse button and select Locate from the popup menu. This will display a set of crosshair cursors:

The intersection of the cursor is indicated next to the cursors. The cursors may be moved with either the mouse or the arrow keys on the keyboard. Note: the arrow keys allow for finer positioning since they move the cursor one pixel at a time in the indicated direction.
Enlarging a Portion of the Graph

Interesting parts of a graph may be enlarged by pressing the alternate mouse button and selecting **Zoom In** from the popup menu. Click at the upper left corner of the region to be enlarged and then hold the mouse button down while moving it down and to the right.

A rubberband rectangle appears. When the mouse button is released, the graph is redrawn showing only the desired region:
Zoom In may be selected again to zoom in further. The alternate mouse button’s popup menu also contains an Undo Zoom selection, which undoes the zoom operations one at a time. You may select Reset Scaling/Viewpoint from the popup menu to redraw the graph using its original scaling.

Moving or Deleting Text

Any text string on the graph may be moved by holding the left mouse button down and moving it to a new location. To delete text, first click on it with the mouse. Then select Delete from the Edit menu.
**Analysis Toolbar**

The analysis toolbar appears directly below the main STATGRAPHICS toolbar:

Seven of the buttons in the leftmost section perform operations such as controlling the data input to a procedure, selecting procedure options, specifying which tables and graphs are displayed, and other basic analysis operations. These buttons are described in detail in the document titled *Analysis Procedures*. The rest of the buttons and input fields are used to interact with graphs. They are only active when a graph has been maximized by double-clicking on it with the mouse.

The graphics buttons perform the following operations:

**Graphics Options**

*Graphics options* – displays a dialog box that allows different aspects of the graph to be changed:
The tabs that appear depend on the type of graph. Changes are made by selecting the desired options and then pressing either Apply to make the changes without leaving the dialog box or OK to make the changes and close the dialog box. Each of the tabs is described in a later section of this document.

Add Text

Add text – used to add additional text to a graph. When pressed, a dialog box is displayed in which the new text may be entered:
- **Direction**: orientation of the text string on the graph.

- **Reference Position**: the location at which the text is positioned. The indicated position of the text string will remain fixed if the graph or text is resized.

- **Fonts**: displays a font selection dialog box to specify the size, color, and font type.

When **OK** is pressed, the new text is drawn on the graph immediately below the top title. To move it, hold the left mouse button down on the text and drag it to a new location.

### Jittering Points

Jitter – offsets points randomly in the horizontal and/or vertical direction to prevent their overplotting one another. The amount of jitter is controlled by the following dialog box:

Move the slider bars to set the maximum random offset in each direction. Jittering is useful when plotting data involving a discrete variable, so that each data point may be seen. For example, the points in the plot below have been jittered slightly in the horizontal direction:
Note: jittering has no effect on any calculations. It affects only the displayed positions of the points.

**Brushing Scatterplots**

Brush – colors points according to the value of a selected numeric variable. When this button is pushed, a dialog box is displayed on which to choose the variable to use to brush the data:

Select a numeric variable from the list. Also specify whether you wish to brush the points using two colors (normally red and blue) or a color gradient. When the OK button is pushed, a floating dialog bar will appear:
Two color brushing

If "two color" brushing is selected, the left and right limits define the points that will be “brushed” (painted in red) on the plot, according to the following rules:

1. If the lefthand value is less than or equal to the righthand value, all points within the limits will be colored red.

2. If the lefthand value is greater than the righthand value, all points not within the limits will be colored red.

As an example, the plot below shows in red all automobiles for which $15.0 \leq Mpg\ City \leq 19.65$:

By moving the slider bars and watching the colored points change, you can often sense the relationship between the brushing variable and the variables used to create the plot.
Gradient brushing

If "gradient" brushing is selected, points are color-coded based on their location between the lefthand and righthand values. The colors are based on the default palette, which extends from dark blue for points at or below the lefthand value to dark red for points at or above the righthand value. The plot below shows gradient brushing for values of Mpg City between 15 and 46:
Smoothing a 2D Scatterplot

Smooth/Rotate – adds a smoother to a 2D plot or rotates a 3D plot.

For a 2D scatterplot, a smoother is added to the plot, as in the figure below:

The smoothed values are created by sorting the data according to the value of X, estimating the height of the function at each value of X, and then connecting the estimated values with a line.

Mathematically, the height of the function at \( X_i \) is estimated by first finding the \( q \) nearest points in the X direction, where \( q \) is a selected percentage of \( n \). (Note: \( X_i \) counts toward \( q \).) The height of the function \( \hat{Y}(X_i) \) is then calculated using one of four methods:

1. **Running Means**: \( \hat{Y}(X_i) \) is set equal to the average value of \( Y \) at the \( q \) nearest neighbors.

2. **Running Lines**: A linear regression model is fit to the \( q \) nearest neighbors using ordinary least squares, and \( \hat{Y}(X_i) \) is set equal to the estimated value of the regression equation at \( X_i \).
3. **Locally Weighted Regression (LOWESS):** A linear regression model is fit to the \( q \) nearest neighbors using weighted least squares, and \( \hat{Y}(X_i) \) is set equal to the estimated value of the regression equation at \( X_i \). The weight given to each neighbor decreases as its distance from \( X_i \) increases, according to the tricube weight function

\[
T(u) = \begin{cases} 
(t - |u|^3)^3 & \text{for } |u| < 1 \\
0 & \text{otherwise}
\end{cases}
\]  

(1)

where \( u \) is the scaled distance between \( X_i \) and \( X_k \)

\[
u = \frac{X_i - X_k}{d_i}
\]

(2)

and \( d_i \) is the distance from \( X_i \) to its \( q \)th nearest neighbor. This gives points close to \( X_i \) more weight in determining the model in the vicinity of the \( i \)-th point.

4. **Robust LOWESS:** This method begins by applying the LOWESS smooth described above. Residuals are then computed by taking the difference between the observed values and the smoothed line:

\[
r_i = Y_i - \hat{Y}(X_i)
\]

(3)

The LOWESS method is then applied again, this time multiplying the original \( T \) weights by a second bisquare weight function, defined by

\[
B(u) = \begin{cases} 
(1 - |u|^2)^2 & \text{for } |u| < 1 \\
0 & \text{otherwise}
\end{cases}
\]  

(4)

where

\[
u = \frac{r_k}{6m}
\]

and \( m \) is the median absolute residual. This reduces the weights of any large outliers that were far from the first smooth, resulting in a smooth that is resistant to points that don’t follow the pattern of the rest.

When the **Smooth/Rotate** button is pressed, a dialog box is displayed requesting the type of smoother to be added to the plot:
• **Type**: the type of smoother to be applied.

• **Smoothing Fraction**: the percentage of $n$ used to select the $q$ nearest neighbors.

---

**Rotating a 3D Plot**

Smooth/Rotate – adds a smoother to a 2D plot or rotates a 3D plot.

If the Smooth/Rotate button is pushed for a three-dimensional plot, a floating dialog bar is displayed which permits the plot to be rotated:

The dialog bar contains:

1. **Left arrow**: begins dynamic rotation of the plot in the horizontal direction, or stops the rotation if the plot is spinning.

2. **Up arrow**: begins dynamic rotation of the plot in the vertical direction, or stops the rotation if the plot is spinning.

3. **X**: stops all rotation.
4. *Left slider:* rotates the plot in the horizontal direction.

5. *Right slider:* rotates the plot in the vertical direction.

6. *Draw text:* if checked, text is drawn while the plot spins.

7. *Maximum speed:* the maximum frames per second (number of times the program attempts to redraw the plot every second). The maximum attainable speed depends on your computer and the type of graph.

8. *Degrees per frame:* the number of degrees the plot is rotated each time it is redrawn.

9. *Reset:* stops all rotation and redraws the plot from the original viewpoint.

10. *Hide:* closes and hides the dialog box.

Rotating a plot can be very helpful in changing the angle from which a function is viewed or in visualizing three dimensional relationships.
Panning and Zooming

Pan or zoom – used to zoom in on a section of the plot and to pan left, right, up or down. When this button is pressed, scrollbars are added to the plot as shown below:

At the same time, a floating dialog box appears:

The sliders on the dialog box are used to zoom in or out. The scrollbars along the edges of the graph are used to pan back and forth.

You can also expand and contract a graph around its central location on a single axis without accessing the floating dialog box by using the zoom buttons at the far right of the Analysis Toolbar.
Creating Videos

Record Video – used to record interaction with a dynamic graph as a video. See the section on Creating Videos later in this document for details.

Exploring Response Surfaces

Explore – used to interactively explore a contour or surface plot. When this button is pressed, a floating dialog box similar to that shown below is displayed:
At the same time, a small square appears on the surface or contour plot at the current location. The height of the surface at that location is displayed immediately above the sliders.

You may interact with the plot in the following ways:

1. Move any of the sliders to manually change the location of the square.
2. Use the checkboxes on the left to change the factors that are displayed on the X and Y axes (choose any two).
3. Use the Ascend or Descend button to move the mark in the direction of increasing or decreasing surface height. If Automatic is checked, the mark will continue to move in the indicated direction. If Extrapolate is checked, the mark will move beyond the boundaries of the current plot, causing the axes to be rescaled.
4. Use the checkboxes on the right to freeze the value of a selected variable. Only variables checked will be changed when the mark moves.

Press Reset to return to the original view. Press Hide to close the dialog box.
Identifying Points

Identify – used to identify points when clicked on with the mouse. A dialog box is displayed for selecting a variable to use:

Once a variable has been specified, the value of the variable will be written to the Label field on the analysis toolbar when a point is clicked on with the mouse. You can also elect to have labels automatically added to the plot (for all points, for unusual points such as points beyond the control limits on a control chart, or only for points that you click on). The Position field specifies where the labels will be oriented with respect to the points:
Excluding Points

Exclude – excludes points from the analysis. In selected procedures, a point may be excluded from the calculations by first clicking on a point and then pressing this button. The selected point is marked with an X, and the entire analysis is rerun without the excluded point:

Multiple points may be excluded. Clicking on a point that was already excluded includes it again.
Adding New Objects

Add object – used to add additional objects to a graph. When pressed, the following dialog box is displayed:

To add a new object to a graph, first select the type of object from the listbox. Depending on the type of object selected, various options will be available. The available objects are:

1. Text string – adds a text string to the plot at a specific location indicated by \((X1,Y1)\). Enter the desired text in the Text field. The Properties button displays an additional dialog box:

   ![Text Options](image)

   You may choose to orient the text in a horizontal or vertical direction. The Reference Position indicates where \((X1,Y1)\) is located with respect to the string. Use the Fonts button to modify the size, color and other attributes of the text.
2. **Horizontal line** – adds a horizontal line to the plot at a specific location indicated by $Y_1$. The *Properties* button displays an additional dialog box:

```
<table>
<thead>
<tr>
<th>Line Types:</th>
<th>OK</th>
<th>Cancel</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Select the desired line type, thickness and color.

3. **Vertical line** – adds a vertical line to the plot at a specific location indicated by $X_1$. The *Properties* button displays the same dialog box as for a horizontal line.

4. **Function** – adds a line to the plot through the points $(X_1, Y_1)$ and $(X_2, Y_2)$. The line extends over the entire width of the plot. The *Properties* button displays the same dialog box as for a horizontal line.

5. **Line segment** – adds a line to the plot connecting the points $(X_1, Y_1)$ and $(X_2, Y_2)$. Unlike a function, the line does not extend beyond the points. The *Properties* button displays the same dialog box as for a horizontal line.

6. **Rectangle** – draws a filled or unfilled rectangle where $(X_1, Y_1)$ and $(X_2, Y_2)$ define opposite corners of the rectangle. The *Text* field indicates the text (if any) to be displayed within the rectangle. The *Properties* button displays the following dialog box:

```
<table>
<thead>
<tr>
<th>Fill Types:</th>
<th>OK</th>
<th>Cancel</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Select the desired fill type, fill color and outline color.

7. **Ellipse** – draws a filled or unfilled ellipse where $(X_1, Y_1)$ and $(X_2, Y_2)$ define opposite corners of a bounding rectangle. The *Text* field indicates the text (if any) to be displayed within the rectangle. The *Properties* button displays the same dialog box as for a rectangle.
8. Arrow – adds an arrow to the plot together with any specified Text. The Properties button displays the following dialog box:

Select the direction of the arrow, the thickness of the line used to draw it, the arrow color, and the length of the arrow (as a fraction of the dimensions of the plot).

9. Function – adds a curve to the plot. The function to be plotted should be specified in the Function field, as shown below:

You may type in any Statgraphics expression. Use “X” to indicate the position along the horizontal axis. Do not include “Y” in the function statement. The Properties button displays the same dialog box as for a horizontal line.

The following plot shows several objects that have been added to a typical scatterplot:
Overiding Attributes

Override attributes – used to change the attributes of selected objects on a graph. To use this button, first click on a filled area, a point, or a line. The object will be marked. For example, you might click on a selected bar in a tabulation barchart:
Then press the button to display a dialog box similar to that shown below:

Specify the new attributes (type, color, etc.) and press OK. The selected object will be modified as shown below:
Unlike *Graphics Options*, which changes the attributes for an entire set of objects, this button changes the attributes for a single object only.

**Highlighting Points**

_A Highlight_ – used to highlight points based on the value of a selected column. When this button is pushed, the following dialog box is displayed:

Select:

1. A column name in the listbox on the left.
2. One of the 6 radio buttons identifying different conditional operators.
3. A value corresponding to one of the entries in the selected column.

Then push any of the following buttons to highlight a set of points:

- **Highlight** – This button highlights all points that satisfy the stated condition.
- **Blink** – This button turns the current highlighted points on and off repeatedly.
- **Alternate** – This button first highlights all points that satisfy the stated condition. It then highlights all points that do not satisfy the condition. It then alternates between the two states.
- **Cycle** - This button first highlights all points that satisfy the stated condition. It then advances the selected line in the listbox on the right and highlights a new set of points. It cycles repeatedly through all values of the selected column.

A typical set of highlighted points is shown below:

![Plot of MPG Highway vs Horsepower](image)

The *Edit* button is used to replace the listbox on the right with an edit field in which a value may be typed:
Locating Points by Name

Locate by name—highlights all points that match the indicated value of the variable selected by Identify. For example, specifying Make as the Identify variable, entering Ford into the Locate field, and pressing this button highlights all Fords on the plot:

![](https://example.com/plot.png)

Locating Points by Row Number

Locate by row—highlights all points corresponding to the indicated row of the datasheet. This is particularly useful when displaying a scatterplot matrix:
<table>
<thead>
<tr>
<th>Horsepower</th>
<th>Length</th>
<th>MPG City</th>
<th>MPG Highway</th>
<th>Weight</th>
<th>Width</th>
</tr>
</thead>
</table>

Graphs show the relationships between the variables.
Graphics Options

The Graphics Options button on the analysis toolbar (or the Graphics Options selection on the alternate mouse button popup menu) is designed to let you customize every aspect of a plot. It displays a tabbed dialog box, each tab of which is described below.

Layout

- **Background**: sets the color of the background. The background is the area within the plot axes.
- **Border**: sets the color of the border. The border is the area outside the axes.
- **All Fonts**: sets the default font for all graphics text.
- **Axes**: defines the direction of the tickmarks on each axis and the color of the axes. To make changes, push the radio button of the desired item and then press the tickmarks or **Color** button.
- **No gap**: suppresses the small gap between the axes and the first tickmark.

- **No minor tickmarks**: suppresses the drawing of minor tickmarks between each major tickmark.

- **Mode**: determines whether or not axes are drawn along the top and righthand side of plots.

- **Axes thickness**: affects the thickness of the axes.

- **3D effects**: adds a three-dimensional look to the axes as illustrated below:

![Plot of MPG City vs Weight](image)
Grid

- **Direction**: direction of the grid (if any) on the plot.

- **Type**: type of gridlines.

- **Colors**: changes the color of the gridlines.

- **Line Thickness**: thickness of the gridlines (affects solid lines only).

- **Back Grid on 3D Plots**: adds a grid to the background of a three-dimensional plot, as illustrated below:
Points

- **Point Set**: set of points to which the other options apply. Most graphs have only one set (type) of points, although some have more.

- **Point Types**: type of symbol to use when plotting. The blank button will suppress the points completely.

- **Fill Point**: make the point symbol solid, if possible.

- **Point Size**: defines the size of the point symbols.

- **Point Thickness**: defines the thickness of lines used to draw the point symbols.

- **Colors**: when pressed, displays a dialog box to define the color of the points.
Lines

- **Line Set**: set of lines to which the other options apply.

- **Line Types**: type of line to use when plotting. The blank button will suppress the lines completely.

- **Line Thickness**: sets the thickness of the lines.

- **Colors**: when pressed, displays a dialog box to define the color of the lines.

- **3D Effects**: adds a slight 3D shadow to the lines.
Top Title

- **Title**: text to be displayed. Some plots have one title line, while others have two lines. Any numbers or letters inside braces, such as \{1\}, indicates that text is automatically inserted. Usually, the text is a variable name from the data input dialog box, which allows the title to automatically update if the data variable is changed.

- **Vertical**: check to orient the title vertically.

- **Line 1 and 2 Fonts**: press to change the size, color, or font type.

- **Change Font for All Titles**: if checked, changing a font for one title will affect the axis titles as well as the top titles.
X-Axis, Y-Axis, Z-Axis or Right-Axis

- **Title**: text to be displayed along the axis. Any numbers or letters inside braces, such as `{1}`, indicates that text is automatically inserted. Usually, the text is a variable name from the data input dialog box, which allows the title to automatically update if the data variable is changed.

- **Title Font**: color, size and font type for the axis title.

- **Vertical**: check to orient the title vertically.

- **Tickmark Font**: color, size and font type for the axis tickmark labels.

- **From, To and By**: defines the axis scaling. Tickmarks are drawn beginning at *From*, ending at *To*, with the distance *By* between each major tickmark.

- **Skip**: suppresses selected tickmark labels. A value greater than 0 in this field causes the program to skip the specified number of major tickmarks between each tickmark label.
- **Skip Repeats**: If checked, duplicate axis tickmarks will not be displayed. This option is only available when the tickmarks are non-numeric.

- **No Power**: suppresses the rescaling of axis tickmark labels for very large or very small values. Normally, the tickmark label for a number such as 10,000 is shown as “10” with a power indicator “(X 1000)”. If *No Power* is checked, the label will be displayed as “10000”.

- **Axis Labels**: for the X axis only, the orientation of the tickmark labels.

- **Scaling**: the type of axis scaling desired. In addition to the default arithmetic scaling, two types of logarithmic scaling are available: one in which all tickmark labels are powers of 10 and a second in which the original tickmark labels are retained.

- **When data change**: affects whether the specified scaling will be held constant if the data change or will adapt to the new data.

- **Reverse tickmarks**: reverses the tickmarks so that they decrease in value from left to right (or bottom to top) rather than increase in value.

A typical graph with logarithmic scaling using “Powers of 10” is shown below:
Legend

- **Title**: text displayed over the legend block.
- **Legend**: text displayed for up to 20 lines of the legend block.
- **Edit**: used to edit the selected *Legend*.
- **Fonts**: color, size and font type for the legend text.
Labels

- **Labels**: labels added to a graph as a group such as in a *Matrix Plot*.
- **Edit**: used to edit the selected *Label*.
- **Fonts**: color, size and font type of all labels in the group.
Text

- **Text**: additional text strings added to the graph other than normal titles, tickmarks, labels, or legends.

- **Edit**: click here to modify the text string highlighted in the *Text* field.

- **Reference Position**: the location at which the text string is positioned (remains stationary when the text is resized).

- **Direction**: the orientation of the text.

- **Fonts**: changes the color, size and font type for the text string highlighted in the *Text* field.

- **All**: changes the color, size and font type for all of the text strings.
Fills

- **Fill Set**: type of fill to be changed by the other selections on the dialog box.

- **Fill Types**: type of fill.

- **Color**: characteristic affected when the *Colors* button is pressed.

- **Colors**: affects the color of the interior or outline of the fill, depending on the setting of the *Color* button.

- **3D effects**: if checked, adds 3D shadowing to some filled areas, as in the barchart shown below:
Palette
When contour plots are drawn, the value at any point may be displayed using colors determined from a special color palette.

- **Color Ramp**: set of colors along which interpolation is performed when displaying the contour values. The dialog box above shows a *cold to hot* ramp. With such a ramp, the lowest values are displayed as blue and the highest values as red. The hot to cold ramp runs from red to blue instead. The black to white ramp, shown below, is useful if the plot is to be printed on a black-and-white printer:
- **Color**: for custom ramps, colors are determined by linearly interpolating between five colors.

- **Change**: press to change the color to the right of the button.

- **Size**: specifies the relative size of the range that will be drawn using each pair of colors. By default, the lowest quarter is drawn by interpolating between the top two colors, the next quarter by interpolating between colors 2 and 3, and so on. The Sizes do not need to sum to 1, since they will be normalized based on the lowest and highest contour level specified when the plot is created.

As an example of a custom ramp, consider the following palette that might be used for terrain visualization:
Only the first 3 colors are used. For the first two-sevenths of the range, interpolation is performed between green and brown. For the remaining five-sevenths of the range, interpolation is performed between brown and gray.

- **Customize**: You may use this button to customize a predefined color ramp. Select the ramp that you want to modify and then press *Customize*. The settings for that ramp will be transferred to the custom fields where you can make changes.

The interpolation is performed linearly between colors in an RGB color space.
Profile
This tab saves current font styles, point and line types, grid selection, and other options in a profile that may later be applied to other graphs.

- **Profile**: three system profiles and 12 user-defined profiles. The profile indicated by a “D” is the default profile applied to new graphs.
- **Load**: loads a stored profile and applies it immediately to the current graph.
- **Save**: saves the characteristics of the current graph in the indicated profile.
- **Save as**: saves the characteristics of the current graph in the indicated profile under a new name.
- **Make Default**: if checked, causes the profile selected to become the new system default profile whenever one of the buttons is pushed.

To save the characteristics of the current graph in a profile, first select one of the *User* buttons. Then press *Save as*. Enter a name for the new profile in the dialog box that is displayed:
To apply the saved profile to a subsequent graph:

1. Create the graph.
2. Select *Graphics Options*.
3. Click on the *Profile* tab.
4. Select the desired profile.
5. Press the *Load* button.

The current graph will be immediately redrawn using the saved settings.
Printing Graphs

The easiest way to print a single graph is to press the alternate mouse button and select Print from the popup menu. The following dialog box will be displayed:

- **Print Range**: You must plot the entire graph.
- **Print Quality**: the resolution at which the output will be printed.
- **Print to File**: If checked, the printed output will be sent to a file instead of the printer. You will be asked to specify the file name.
- **Copies**: the number of copies to be printed.
- **Setup**: Push this button to select a different printer or to change printer options.

Select the desired printer and printer options. Then press OK.

You can print multiple graphs at the same time by selecting Print from the File menu or pressing the Print button on the main toolbar. You can also copy them to the StatReporter or StatGallery and print them there.

Copying Graphs to Other Applications

To copy a graph to another application such as Microsoft Excel, Word or PowerPoint:

1. Double-click on the graph to maximize its pane.
2. Select Copy from the Edit menu, the main toolbar, or using the alternate mouse button. This places the graph on the Windows clipboard.
3. Go to the other application and select Paste.
Saving Graphs

Graphs created in statistical analyses may be saved on disk in image files by:

1. Double-clicking on the graph to maximize its pane.
2. Selecting Save Graph from the File menu or pressing the alternate mouse button and selecting Save Graph from the popup menu.

When selected, a standard Windows file save dialog box will be displayed:

- **File name**: name of the image file to be saved.
- **Save as type**: type of image file. Available types include:
  1. **Windows Metafiles (*.wmf)**: a metafile format that can be pasted into other applications such as Microsoft Word or PowerPoint.
  2. **JPEG 24 Bit Color (*.jpg)**: a compact file format that can be imbedded in an html file or web page.
  3. **TIF Color (*.tif)**: uses the Tagged Image File Format without LZW compression.
  4. **PNG High Color (*.png)**: uses the Portable Networks Graphics format.
5. *Windows BMP High Color (*.bmp):* Windows bitmaps. Note that these files may be very large.

6. *GIF (*.gif):* a compact file format that can be imbedded in an html file or web page.

For graphs that will later be imbedded in documents created by Windows applications, Windows metafiles are usually the most convenient. For graphs that will be viewed using a web browser, JPEG files are most commonly used.

**Creating a Video**

AVI videos can be created which record graphics output. For example, suppose you wished to record interaction with a response surface such as that shown below:

To begin recording a video, maximize the graph to be recorded. Then do any of the following:

1. Press `<Ctrl><M>` anywhere on the graph.
2. Press the right mouse button and select *Start Video* from the popup menu.
3. Press the *Record video* button on the analysis toolbar.

If you use the third method, the following floating dialog box will appear:
To record a video:

**Step 1:** Press the *Compression* button. This will display a dialog box on which you may select the type of compression to be used to reduce the size of the video file:

![Video Compression Dialog Box]

From the *Compressor* list, select the codec that you wish to use. Codecs compress and decompress the video files that are created in order to reduce the size of the files. You may also select a different *compression quality*.

**Step 2:** Press the *Start* button to begin recording the video. While the movie is being recording, you will see a REC indicator at the far right of the status bar at the very bottom of the main STATGRAPHICS window. Manipulate the graph in any manner that you wish.

**Step 3:** To stop recording, press the *Stop* button (you may also press `<Ctrl><M>` again or press the right mouse button and select *End video* from the popup menu).

**Step 4:** Press the *View* button to view the recorded video.

**Step 5:** Press the *Save* button to save the video in a file. The following dialog box will be displayed:
Indicate the name of the file in which the recording will be saved.

To replay the video, use Windows Explorer to locate the file and double click on it. Your default video player will be used to play back the video.